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1.

Limited Warranty
Acuity Technologies makes the following limited warranties. These limited warranties extend
to the original purchaser and to no other purchaser or transferee.
Limited One Year Parts and Labor Warranty
Acuity warrants this product and its parts against defects in materials or workmanship for a
period of one year after the date of original retail purchase. During this period, Acuity will, at
its option, repair or replace a defective product or part without charge to you.
Warranty Conditions
The above LIMITED WARRANTIES are subject to the following conditions:
1. Warranties extend only to products manufactured by Acuity.
2. Warranties extend only to defects in materials or workmanship as limited above. Warranties
extend only to defects which occur during normal use and do not extend to damage to products
or parts which results from disassembly, alteration, repair, modification, faulty installation or
service by anyone other than an authorized Acuity service center, damage to products or parts
caused by accident, abuse, misuse or improper maintenance, mishandling, misapplication, or
damage caused by acts of God.
3. You must retain your bill of sale or provide other proof of purchase.
4. Any replacement parts furnished at no cost to the purchaser in fulfillment of this warranty
are warranted only for the unexpired portion of the original warranty.
This warranty gives you specific legal rights, and you may also have other rights which vary
from state to state. All warranties required to be implied by state law are expressly limited to
the duration of the limited warranties set forth above. Some states do not allow limitations on
how long an implied warranty lasts, so the above limitation may not apply to you. With the
exception of any warranties required to be implied by state law as hereby limited, the foregoing
express warranty is exclusive and in lieu of all other warranties.
In no event shall Acuity be liable for special, incidental, consequential or punitive damages,
including, without limitation, injury or damage to persons or other property, inconvenience,
loss of goodwill, lost profits or revenue, loss of use of this product or any associated equipment,
cost of substitutive equipment downtime costs or claims of any party dealing with purchaser
for such damages, resulting from the use of this product or from defects in this product, or
arising from breach of warranty or contract, negligence or any other legal theory. Some states
do not allow the exclusion or limitation of incidental or consequential damages, so the above
limitation or exclusion may not apply to you.
This device complies with part 15 of the FCC Rules. Operation is subject to the
following two conditions
(1) This device may not cause harmful interference, and (2) this device must accept any
interference received, including interference that may cause undesired operation.
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Note: This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to part 15 of the FCC rules. These limits are designed to provide reasonable
protection against harmful interference when the equipment is operated in a commercial
environment. This equipment generates, uses, and can radiate radio frequency energy and, if
not installed and used in accordance with the instruction manual, may cause harmful
interference to radio communications. Operation of this device in a residential area is likely to
cause harmful interference in which case the user will be required to correct the interference
at his own expense.

Obtaining Warranty Service
1. Contact your Acuity distributor or call Acuity Technologies at (650) 369-6783 or email
inquiries@acuitylidar.com to obtain a return merchandise authorization (RMA) number within
the applicable warranty period. An RMA number must accompany any product returns.
2. Ship the product to Acuity, together with your bill of sale or other proof of purchase. your
name, address, description of the problem(s). Print the RMA number you have obtained on the
outside of the package.

Page 5

2.

Overview

The AL-500 is an eye safe two-axis scanning Lidar. It includes a pulse laser rangefinder, a polygonal
scanning mirror, and a processor with 100 Mbit Ethernet for client communications. The AL-500
operates by measuring the time difference between a transmitted laser pulse and a received reflection.
Scene regions are scanned by deflecting the laser beam with a high-speed mirror to take a line of
sample points in a range of up to +/-60 degrees from horizontal. The entire scanner also rotates on its
base at up to 10 revolutions per second, with unlimited azimuth rotation. The azimuth and elevation
fields of view and scan speeds may be changed before each scan, allowing rapid transitions between
fast panoramic scanning and detailed scanning of areas of interest.

3.

AL-500 Operation

3.1 Mounting and Maintenance
The AL-500 has been fully factory calibrated to its design range and angular accuracy and
repeatability. It should not normally be necessary to perform additional calibration when installing,
other than boresighting to confirm the scan zero angle and mounting angles and scanning origin
relative to the mounting system origin.
Before powering up, the AL-500 must be securely attached to an appropriate mount. The best scan
accuracy is obtained when the mount is fixed and rigid to prevent flexing and vibration. The version
with the connectorized base must be mounted securely to a platform using the four ¼-28 threaded
holes, using bolts with threadlocking compound. The version with the post mount and potted cables
must be mounted in a .500 to .520 inch diameter hole in a metal plate 1/8 to ¼ inch thick using the
supplied ½-20 nut and threadlocking compound. See the datasheet dimensional drawing for mounting
details.
The AL-500 is a rugged system designed for use on mobile platforms. However, it should be
protected from severe shock and vibration, such as that which might be experienced on a vehicle
without suspension or with high engine vibration. In these cases the scanner should be mounted with
shock absorbing mounting feet or pads. The scanner may be lifted by the base or the outer case.
The motors for the turret and scanning mirror are brushless DC motors which do not need
maintenance. Opening the scanner or breaking any seals will necessitate factory repair and
recalibration.
The front window is IR transparent filter glass, and should be kept clean and free of scratches and
dirt, though a small amount of scratching or contamination will not normally affect operation. Do not
put excessive pressure on the optical window.
Clean the scanner case with soap and water only. Do not use alcohols, acetone, or other solvents,
which will soften the outer coatings.

3.2

Power/Signal Connections and Initialization
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Wire your power supply to the power / GPS data input cable and plug in the connector with the
scanner power switch off. Plug the ethernet cable into a hub, switch, or router or directly to a
computer and turn on the power supply. A crossover is not needed as the scanner supports AutoMDIX configuration.
Power / Signal Input cable
Red: Power
Black: Ground
White: Precision Pulse (PPS) input, TTL levels 0-3.3 or 0-5 V. Connect to ground if unused.
Green: Serial input: 0-3.3V, 0-5V TTL, or +/- 3.3 to +/- 9V RS232 levels. Active low logic. Connect
to ground if unused.
Drain Wire/Foil Shield: Ground
Start the PointWorks.exe application on a Windows PC connected to the same network and then turn
on the scanner. About 3 seconds after power up the scanner will emit a single short beep. If a fault
condition is detected during self test the scanner will beep 3 times. The three beeps may occur after a
longer delay. In this case, click the Display Scanner Log button on the PointWorks interface to see
error codes. If the scanner detects a fault in the Ethernet controller it will emit 5 beeps on power up.
Successful connection is unlikely in this case.
Messages indicating the scanner has successfully connected to PointWorks should appear in the
Status Messages box. To activate the scanner motors issue a Scanner Wake command with the
interface “Wake” button. The turret will rotate until it passes the zero orientation and then back to it.
The scanning mirror motor will be tested and stop.
To take a scan with the default scan start and stop positions and sample rate click “Send Scan Line
Parameters” followed by “Set Scan Azimuth Parameters” and “Queue Single Scan”. In each case the
response “Command Acknowledged” should appear in the messages window. The scanning mirror
will spin up, the turret will move to the starting azimuth and the scan will begin. When complete a
message will appear in the PointWorks status window and the turret will stop but the mirror will
continue to spin.
Scans may be taken immediately after power up and self test but scan data accuracy and sensitivity
will be best after a warmup time of approximately 3 minutes. To power cycle the scanner, leave the
switch off for three seconds.
See the section Using the PointWorks Executable for details on establishing a connection between the
host and scanner and displaying the log.
CAUTION
During the “wake” rotation, the scanner operates in a torque-limited mode. If it hits an obstacle it will
continue to press lightly against it for several seconds before entering a fault state. Once the scanner
completes this turn it enters full power mode and is capable of very rapid, forceful motion. A collision
while moving rapidly may cause damage or injury to equipment and people. Keep the area around the
scanner clear while it is operating.
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3.3

Scanning Operation

The AL-500 acts as a scan data server for a host machine that communicates through a set of
commands transmitted via Ethernet using TCP-IP. A scan is 1 or more nearly vertical lines of range
data. The vertical scans occur at high speed while the azimuth angle changes relatively slowly.
Vertical scan lines are actually slightly sloped, dependent on the horizontal and vertical scan speeds
set.
While not scanning, the elevation and azimuth motor speeds may be set to zero or any valid scan
speed with the Immediate Elevation Speed and Immediate Azimuth Speed commands. This may be
used to stop the elevation motor after a scan or to spin it up before a scan to reduce the scan start
delay once a scan command is issued.
Depending on the scanner version and the sample rate selected the scanner can detect up to 4 returns
per laser pulse if the laser spot falls partially on surfaces at different distances. At 200000 samples per
second or less, up to 4 returns can be collected. At less than 400000 sps, up to 2 returns can be
collected, and above 400000 only the first return is collected.
If no return is detected after the time required for a signal to return from a surface at maximum range,
a time out signal ends the ranging interval. The maximum distance at which an object will reflect a
measurable return signal depends on the reflectance of the object and the amount of ambient light
present.
If an object is in the scan field at a distance closer than the minimum measurement distance, it may be
unseen, or an incorrect, slightly longer range may be indicated for it.
No messages are displayed while scanning. To determine if the scan is progressing normally click
“Get State” at the top of the PointWorks window. It should show “In Last Scan”, or if a second scan
was queued and the first has not yet completed, “In First Scan”. Once a scan is completed a message
will appear in the status window with the number of lines acquired. If any checksums or line
sequence errors occurred in the scan an error message is displayed.
3.3.1.1

Laser Spot Size

The laser beam has an initial diameter of 10mm, so this is the best lateral resolution of the system at
short range. The beam diverges at 1 milliradian. The spot size at any distance may be calculated as
Spot Size = Initial Diameter + (Beam Divergence x Distance).
3.3.1.2

Scanner Coordinate System Origin

The X, Y, Z origin for the data output from PointWorks is centered over the mounting screw holes in
the base, 168.7 mm above the bottom of the base.
3.3.1.3

Optical Considerations

Returns from Windows and Other Reflective Surfaces
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The point data returned when scanning over a reflective surface such as a window will depend on
several factors. If there is much dirt on the surface or if the surface has a diffuse component and/or is
nearly perpendicular to the beam, there may be a return from the surface. There may also be a return
from whatever the scanner sees reflected from the surface, as if looking in a mirror. Finally, there will
likely be a return from whatever, if anything, is on the other side of the window. Two or more returns
are also not uncommon from looking through windows with screens over them
The scanner is most sensitive to returns from roughly 30 meters, so at this distance you are most
likely to see a return from relatively clean windows. Perhaps the best way to observe this out is to
scan the beam through a window, say looking out from inside a room, pointed up into space. Then
look for “mirage” walls or ceiling appearing in the air outside the room.
Returns from Retroreflective Surfaces

Street signs and other road safety markers have glass or plastic beads that reflect light back in the
direction it came from. This is a strong effect, and it is possible for a pulse to travel several times the
nominal maximum distance that the scanner can see and return with enough strength to interfere with
the measurement of returns from a subsequent pulse. The apparent range will be much closer than the
actual object in this case. This may also happen with a shiny surface perpendicular to the beam. This
effect can be managed to some extent by reducing the pulse rate so there is more time between pulses,
since the scanner only “looks” for a return in the appropriate time window just following a pulse.
Viewing Multiple Returns in PointWorks

If multiple returns from a single laser pulse are detected by the scanner, they are all displayed in
PointWorks by default. If the “Return 1” box on the PointWorks interface is unchecked when
displaying a scan file it will display only 2nd, 3rd, and 4th returns. A display point count of zero in that
case most likely means the “Capture Multiple Returns” box was not checked when the scan was
taken. Otherwise, there will almost certainly have some 2nd returns at edges of objects, unless the
pulses are very widely spaced.

3.4

Azimuth Motor Path Planning

The turret of the AL-500 moves through scans at constant speed. To accomplish this, the AL-500
performs intelligent path planning which moves the azimuth motor into the correct position and speed
for the commanded scan. While one scan is executing, another may be queued so that the next scan
may be anticipated by the path planning algorithm immediately upon completion of the prior scan.
Turret positioning and speed commands are also available to preposition the turret for quick response
to a scan command.

3.5 Displaying a Scan
Scans are saved automatically with a timestamp file name while scanning if “Record Scan to Disk” is
checked. Once a scan has been taken it may be displayed by clicking “Display Scan”. To display a
previously saved scan use File->Open, then “Display Scan”.
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A 3D rendering of the scan is generated with zero azimuth and elevation in the view center. If the
scan did not include zero elevation and azimuth, there may not be any image visible unless the mouse
is used to pan to the region scanned. If the scanner was not oriented vertically when the scan was
taken and the inclinometer auto-rectification function is not activated, the screen image will be rotated
from the world. Select the menu item Help->Viewing Hints for navigating in the scanned space, and
see the PointWorks section below.
Scans of up to 2 billion lines may be captured and saved but display is limited to approximately 15
million points. To display a larger file, use the decimation options in the PointWorks display settings
to display a lower resolution version of the data file.
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4.

Software and Documentation

The following software and documentation is included with the AL-500:
This user’s guide.
The AL-500 Datasheet
Precompiled PointWorks for Windows 10.
Acuity Scanning Application Programming Interface library and source code.
C++ source code for the scanner interface portions of PointWorks and workspace files
developed with MS Visual Studio. This is intended as an example for software development
using the Acuity API or a simple tool for scan acquisition.
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Once a scanner is attached, depending on the type of scanner (AL-500 or AL-500AIR) some
items will be disabled (greyed out).

4.1
Software Installation for Windows
The PointWorks software does not need an installer, and may be executed directly after copying to
disk. PointWorks contains routines for capturing scan data from Acuity scanners, transforming and
calibrating it, and displaying it using OpenGL. PointWorks requires OpenGL version 3.3 or higher to
be installed on the system. OpenGL is installed on most systems with preinstalled Windows. You can
determine the version of OpenGL on a machine by using the free download glview program.
The Executable File Set directory in the root folder of the distribution contains a PointWorks
executable and the necessary runtime files other than the OpenGL libraries for capturing data from
Acuity scanners and processing and viewing the scans. It also contains a subdirectory with some
sample scan data that can be viewed and exported in other formats.
If you have issues with missing OpenGL libraries or drivers a helpful site is
https://www.khronos.org/opengl/wiki/Getting_Started From their introduction:
“In all three major desktop platforms (Linux, macOS, and Windows), OpenGL more or less comes with the
system. However, you will need to ensure that you have downloaded and installed a recent driver for your
graphics hardware.”

4.2
Other Operating Systems
The source code provided may be used as the basis for building applications under other operating
systems, though it has only been implemented by Acuity under Windows 10.

4.3

Using the PointWorks Executable
SAFETY WARNING
The scanner can move rapidly and laser light is emitted from the window during program
operation. Although the laser output is safe in normal operation, care should be taken to
avoid circumstances that might result in injury or damage. Ensure that the turret is free to
move and that the system is firmly mounted on a secure base. Do not look at the window
using magnifying optics such as binoculars.

When PointWorks starts it will open two windows, a control / status console and an empty graphics
display window. Assuming your ethernet connections and settings are perfect, you will see a
sequence of startup messages confirming connection. If an error occurs in connecting to the scanner,
try the things suggested in the status window and the section below.
4.3.1 Ethernet Connectivity
It is recommended that the scanner be used on a 100 Mbit ethernet link with minimal other activity
since the scanner can use a substantial portion of the bandwidth of this link depending on the
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sampling speed selected. Wireless network connection to the host computer is not recommended due
to wide variations in wireless data rates. The ethernet cable RJ-45 jack may be connected to a
network switch or router.
If you connect the scanner and client computer to a network with a DHCP server, the scanner will get
an IP address from it and identify itself with the host name “AL-500”. Otherwise it will start with an
IP address of 192.168.1.191. The scanner and client use TCP and ports 9760 and 9761 for
command/ack and data transfer. This is usually the easiest way to start since no configuration of the
host computer should be necessary.
It may be helpful to put your computer into airplane mode to help ensure the wired ethernet adapter is
included in the search for the scanner. Some versions of Windows may not search on the wired
connection if the wireless connection is enabled.
If you are connecting the scanner directly to a Windows computer ethernet port or USB to ethernet
converter separate from a network, also configure the Windows primary or alternate TCP settings for
the wired ethernet adapter to use a fixed IP address starting with 192.168.1 rather than requesting one
using DHCP.
This can be done from the
Windows Network Connections -> Local Area Connection (x) -> TCP-IP -> Properties dialog.

You may need to turn on network sharing and discovery after entering Airplane mode or disabling the
wireless adapter. You can check the IP address by opening a command window and entering
ipconfig/all and looking for the IPV4 address associated with the ethernet adapter connected to the
scanner. The PointWorks software will then be able to initialize the machine’s network interface and
connect with the scanner without a router/DHCP server.
After power up it typically takes several seconds (or more, depending on the router and network
configuration) for the network router or client to detect the scanner so that it is visible, so allow some
time for the scanner to be discovered before starting PointWorks, since it tries only briefly to discover
a scanner.
When the scanner is connected and powered up it will also respond to a “ping” command to
192.168.1.191.
4.3.2 Taking a Scan with PointWorks
Before proceeding ensure that the scanner is securely mounted and that it will be able to rotate
without striking anything.
When PointWorks starts, messages indicating the scanner has successfully connected to PointWorks
should appear in the Status Messages box. To activate the scanner motors issue a Scanner Wake
command with the interface “Wake” button. The turret will rotate and stop with the optical axis
aligned with the switch and mounting screw holes in the base. Internally, the scanning mirror motor
will be tested. During this time there will be a few seconds when it will not respond to other
commands.
To take a scan with the default scan parameters click “Send Scan Line Parameters” followed by “Set
Scan Azimuth Parameters” and “Queue Single Scan”. In each case the response “ Command
Acknowledged” should appear in the messages window. The scanning mirror will spin up followed
by rotation of the turret to the starting azimuth and scan will start. Parameters for a 90 degree scan
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have been coded into the demo and appear as the default values in the ‘Scan Line Setup’ and ‘Scan
Azimuth Setup’ input groups in the upper left of the interface panel.
On scan completion the turret rotation and laser pulsing will stop. The internal scanning optics will
continue to spin.
To configure the scan speed, point density and sample rate, the scan line and scan azimuth speeds
may be set using the following commands.

4.3.2.1 Scan Line Setup
The scan line parameters are the scan mirror speed in encoder counts per second, the starting
elevation in encoder counts, the number of samples per line, and the spacing, in encoder counts,
between samples. Once set, the scan line parameters are used for all scans until changed, or until a
‘sleep’ or power cycle occurs.
Elevation Start: The number of encoder counts above or below view center to begin
acquiring samples. Each line in a scan consists of 1 to 6667 range measurement points.
Sample Spacing: The number of elevation encoder counts between laser pulses (range
samples). The maximum sample spacing is 20, and the minimum is 1, subject to the
maximum sample rate limit.
Samples per Line: The number of range samples to acquire in each scan line. Elevation start,
sample spacing and samples per line determine the elevation angle of the last sample in each
line. Attempting to set a combination that results in an end angle below -60 degrees will
result in an error.
Elevation Speed: Set in scanning mirror encoder counts per second. Limits are 200,000 to
4,000,000, or 5 to 100 mirror revolutions per second. Since there are three line scans per
revolution, the maximum line rate is 300 lines/second.
Multiple Returns per Sample: At times the laser spot may fall partially on an object at one
range and partially on one or more objects at other ranges, such as when first impinging on
the edge of a building in front of other objects. The scanner may be configured to acquire up
to four returns from surfaces separated by approximately 1 meter or more in distance.
Surfaces closer together may generate only one return, with the range of the closer one being
sampled. When the Multiple Return option is selected for a scan, scans at sample rates below
200,000 per second will capture the first 4 returns per laser pulse. Scans at sample rates
between 200,000 and 400,000 will capture the first 2 returns, and at rates above 400,000 only
the first return is captured.
Scanner Sample Rate Calculation: The laser pulse and distance measurement sample rate is
controlled by the elevation motor speed and the elevation sample spacing. The maximum
laser pulse rate for the short range version of the scanner is 800,000 per second, and the
maximum rate for the long range version or when multiple return sensing is enabled is
200,000 per second. Attempting to set a combination of motor speed divided by sample
spacing to more than this limit will result in an error.
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4.3.2.2 Scan Azimuth Setup
The scan azimuth parameters are the azimuth starting and ending locations in encoder counts and the
azimuth speed in encoder counts per second. Once set, the scan azimuth parameters are used for all
scans until changed, or until a ‘sleep’ or power cycle occurs. The
Azimuth Start: The turret rotation location at which to start a scan. Valid start and end
locations are -2,000,000,000 to 2,000,000,000. The zero location is the orientation of the
turret after the rotation that occurs after power up or after a sleep command is issued, facing
forward.
Azimuth End: The azimuth location does not reset with each revolution. For example, a start
location of zero and an end location of 120,000 will result in a scan of 3 complete rotations.
Issuing a second scan command without any changes to the azimuth parameters will cause
the scanner to rotate back to the start position of the previous scan, which may be multiple
revolutions.
Azimuth Speed: Azimuth rotation rate in encoder counts/second. Forward is clockwise
viewed from above. The speed must agree with the scan direction implied by Azimuth Start
and Azimuth End Valid speeds are 0 to +/-400,000 counts per second.
Indefinite Duration Scans: If the azimuth start and end locations are the same, scanning will
start at that location and continue at the speed commanded until terminated by an Abort Scan
or Sleep command. If the azimuth start and end locations are the same and the commanded
speed is zero scanning will start at the azimuth start location and continue at that location
until terminated. Issuing another scan command will not terminate an indefinite scan.
Set Azimuth Gain Reduction: Adjusts the stiffness of the turret motor servo and the
maximum rotational acceleration rate of the turret. The default is a high reduction value to
allow operation from a lightweight vehicle or tripod. Lower gain reduction values may cause
motion or vibration of the structure or vehicle the scanner is mounted to. To increase the
stiffness set the gain reduction to a lower number. Depending on the inertia and rigidity of the
structure the scanner is mounted to, the scanner will start to buzz or vibrate at lower gain
reduction values (higher gain and stiffness), so decrease it one count at a time and make some
turret moves with Set Azimuth Position to evaluate the optimum stiffness.
Since the gain reduction should be set before the Wake command is used to enable the turret
motor, this command may be used before the Wake command following power up, and the
value set is preserved across sleep/wake cycles, though not across power cycles.

4.3.2.3 Starting, Stopping, and Queueing Scans
Queue Single Scan: Starts a scan, or queues one for execution after any currently executing
scan is finished. The scanning mirror will come to the configured speed, and the turret will
then rotate rapidly to the azimuth start position and rotate at the configured scan speed to the
azimuth stop position, and then stop. The mirror continues to spin after the scan until its
speed is changed by another command. Enter 0 in the elevation speed field and click
Immediate Elevation Speed to stop the mirror motor.
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A second scan may be configured and queued while one is executing by setting scan line and
azimuth parameters followed by the Queue Single Scan before an executing scan completes.
Abort Scanning: Stops any scan in progress and halts the scanner motion. This will also
cancel any queued scan.
End After Current Scan: This will complete any presently executing scan and then cancel
any queued scan.
Queue Cycling Scan: May be used to scans repeatedly over the same area. Scanning begins
as with Queue Single Scan, but reverses and scans in the opposite direction when the end
azimuth location is reached. When the beginning azimuth location is reached, scanning again
reverses. This repeats until ‘Sleep’ or ‘Abort Scanning’ is clicked. Queueing is not effective
with Cycling scans since Abort will also cancel any queued scan.

4.3.2.4 Inclinometer Commands
The AL-500 contains an inclinometer to measure the tilt angles of the scanner while mounted
approximately vertically on a stationary mount such as a tripod. Inclinometer data may be used to
rectify scans relative to vertical if the scanner is inclined while scanning a scene. This is a low
bandwidth sensor that will not capture dynamic motion such as ground or air vehicle motion.
Init Inclinometer: Rotates the scanner through 360 degrees, clockwise and then
counterclockwise to initialize the two-axis inclinometer. Inclination values are then included
in the header data for each scan line. Once the inclinometer has been initialized inclination
angle is included in the scan data and to rectify displayed data to vertical.
Get Inclinometer: Retrieves and displays the present pitch and roll angles of the scanner.

4.3.2.5 Other Commands
Sleep: Resets the scanner to a power-up condition. Both motors are turned off. Scan
parameter values are cleared. Only a few commands such as Wake, Display Scanner Log and
Azimuth Gain Reduction may be used while sleeping. Issuing a Sleep command will
immediately abort any scan in progress.
Wake: Must be used to enable the scanner motors after power up or after a Sleep command
before configuring the scan line and azimuth parameters or using any commands requiring
motor motion. The scanner log is cleared.
Get State: Retrieves and displays the current scanner State. See the file datapackets.h for a
list of scanner states. This may be used to determine whether the scanner is presently
scanning or is ready to scan. If the Sleeping state is entered unexpectedly other than after
power up, the scanner may have encountered an unrecoverable error.
Display Scanner Log: Retrieves and displays the list of codes of events and errors that have
occurred since the last Wake Command. May not be used during a scan. Code values 1 to 19
correspond to normal scanner state transitions. Codes 20 to 99 correspond to receipts of
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external commands. Codes 100 to 199 correspond to internal scanner errors. Consult Acuity
if these occur. Codes 200 to 299 correspond to external command errors, e.g. commands to
the scanner containing invalid parameter values or issued when the scanner was not ready to
accept them. Codes 300 to 299 correspond to transient errors that were corrected or
conditions such as overtemperature warnings that may soon result in an error and prevent
scanning.
The titles of each event/error code may be found at the top of the file datapackets.h in the
PointWorks source code.
Disconnect: This command closes the TCP connection to the scanner. This allows
disconnection of the ethernet cable without power cycling the scanner and restarting host
software, or power cycling of the scanner without restarting host software.
Reconnect: Establishes or re-establishes the TCP connection. This may be used after the
Disconnect command and/or scanner power cycle, or if the host software attempted to
connect to the scanner before the scanner was powered up.

4.3.3 Displaying a Scan
Help for the interactive display of scanner output is available in PointWorks by clicking the “Show
Viewing Hints”.
After a scan is complete the scan data may be displayed in perspective or orthographic view with
‘Display Scan’. This can also be used to choose stored scans to view. The view may be rotated,
panned, and zoomed using the left mouse button and the mouse wheel. Click and hold the left button
and move the cursor to rotate the view. Rotate the mouse wheel to zoom forward/back in the direction
of the cursor: to move forward and to the left move the mouse cursor to the left side of the screen
while using the wheel. Hold the control key while rotating the wheel to zoom faster.
To display information about a point, right click on the point. When zoomed in so that points are
separated it may be difficult to get the cursor positioned exactly on a point.
Uncheck 'Perspective View' for an orthographic view. Note that in an orthographic view one can only
manipulate the view direction and scale; the viewer position is always “infinitely far" from the object,
so points can never be behind you as they can with perspective view.
PointWorks can acquire and store scans of indefinite length, but display of large scans is limited by
the system main or graphics memory. If a scan is too large to display completely it can be opened and
then displayed with the decimation or geometric clipping values appropriately set to display selected
data.
Since the AL-500AIR scans in only the vertical (as seen on the PointWorks display) the horizontal
scaling in the display is set to separate line scans by the size of each display point. The Line
Separation Ratio may be changed to adjust the apparent relative scales in the display.
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4.3.3.1

Geometric Clipping

The Azimuth, Elevation, Distance, X, Y, and Z limit filters can be used to hide unwanted data. These
can be used to look at “slices” of scans or to remove uninteresting distant points. These affect only
display, not scan storage. The X direction is directly out the front of the scanner, Z is the scanner long
axis and Y is normal to those through the intersection of the mirror rotation axes.

4.3.3.2

Viewing Multiple Returns per Sample

If a scan was collected with the Multiple Returns per Sample option enabled, by default all returns
will be displayed in PointWorks, but it will not be evident which returns come from the same
samples. Selected returns can be hidden by unchecking the Return1… Return4 boxes in the UI. This
will mask points with those return number(s), showing a sparser field typically of object edges or
returns from foliage.

4.3.3.3

Oversampling and Averaging Multiple Samples

Individual point samples have some random point-to-point fluctuation in distance measured, which
can be reduced by averaging multiple samples. Since the scanner can sample at point spacing smaller
than the laser spot size, multiple points can be averaged to reduce this fluctuation, which is generally
larger when the ambient light is high and the return signal strength is low, e.g. for longer distances
and low reflectance surfaces. Averaging multiple samples improves the depth resolution in proportion
to the square root of the number of samples averaged.
If the averaging span value set in the PointWorks interface is above zero, the measured distance of
each point is averaged with that of its neighbors to arrive at a smoothed value for the point. Since the
beam size and point spacing increase with distance from the scanner, the span is specified in degrees.
For a given angular averaging span the number of points averaged will depend on the point density of
the original scan.
When averaging is applied to a scan taken with multiple returns enabled, only the first points returned
from each sample are averaged. Other points are displayed or exported without averaging.

4.3.3.4 Decimation
The number of output points is not reduced during averaging. If fewer output points are desired, enter
non-zero values in the decimation boxes. Decimation will reduce the number of points in azimuth and
elevation that are output for display or file export. For example, a value of 10 will display one point in
10 in that direction. For display and for external file formats such as .las, decimation is performed
after averaging (smoothing). For .alf scan line format file output, the raw line data is decimated and
output, so no smoothing is performed.

4.3.3.5

Signal Strength Display
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Reflected laser signal strength is detected for each return and may be displayed by selecting Laser
Signal Strength as the Value to Colormap in the PointWorks Interface. This is a roughly logarithmic
scale, allowing a wide dynamic range to be captured.

4.3.3.6

Ambient Light Display

Similarly, background or ambient light intensity is also detected during a scan and may be displayed
on each pixel rather than the default range color coding. This is only representative of light near the
laser wavelength since other light is filtered from detection. The reflected laser signal is largely
excluded from this display. The relative reflectance of different materials can be distinguished by
examining their relative brightness in this display. Sunlit and shaded areas can also easily be
distinguished in this display.
Very high signal levels such as directly from the sun or from a mirror reflection of the laser beam
may saturate the scanner’s detector. In this case streaking, or residual high ambient signal level, may
persist and be visible in a few scan lines following saturation.
4.3.3.7 Data Color/Grayscale Coding and Rainbow Factor
The distance from scanner, the ambient light from a point, or the reflected laser signal strength from a
point may be displayed either color-coded or as a grayscale intensity. By default, the distance from
the scanner is color-coded. In the default encoding, the colors go from blue to red as the value
(distance (the default), ambient brightness, or signal strength) changes from the lowest to highest
value found in the scan. More rapid color changes can be displayed by increasing the Rainbow Factor
above 1. Colors will then be cycled through more rapidly, from blue to red and back to blue
repeatedly as the valued being encoded increases.
If displaying in grayscale (Grayscale box checked) the rainbow factor used is always 1.
Since the range of the color or grayscale display is normalized by the minimum and maximum values
in the scan data, any light source such as the sun or a lamp will skew ambient light display so that the
rest of the points appear black or very dark in grayscale, or blue in color.
4.3.4 Processing and Exporting a Scan
The data from a scan is stored in a scanner-dependent binary format when the scan is taken. To export
a scan to a choice of common point cloud file formats, open an acuity lidar format (.alf) saved scan
and then then use Save As to save to a .LAS format file. Smoothing (averaging), decimation, and
geometric filtering of the output can be performed by setting the appropriate selections as described
above. This can take some time and storage space for large scans. Not all formats are able to retain
all types of scan data. PointWorks can read, process, display and write scan files without a scanner
attached.
4.3.5 Status Message Window
The status message window displays scanner responses to commands as well as progress and status
information from PointWorks. If the scanner is not operating as expected, the 'Display Scanner Log'
button can be used to list the parameter values in effect and the command and internal errors that have
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occurred. If an internal scanner error persists and is affecting scanner operation, contact Acuity for
assistance. A screen shot of the scanner log display showing the error will help to resolve the issue.
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5.

Developing Applications with the PointWorks API Source

5.1 Introduction and Installation
5.1.1 Development Environment
To compile and modify the PointWorks software you will need a development environment and C++
compiler. You will also need OpenGL 3.3 or higher installed on the computer. OpenGL generally
comes preinstalled on Windows PCs. PointWorks builds using the static versions of the OpenGL
libraries opengl32.lib and glu32.lib. It it also uses extensions glew and glfw libraries, header files, and
C/C++ source files, as well as LASlib header files and libraries. These are included with PointWorks
so it can be modified and rebuilt without downloading and installing other packages.
PointWorks has been developed using Microsoft Visual C++ and Visual Studio. A free version,
Visual Studio Community, can be downloaded from Microsoft.

5.1.1.1 Using the API and PointWorks Library
The PointWorks software is divided into three modules of code. The first contains the PointWorks
Library, proprietary calibration algorithms and display code which is Windows 10 and MFC specific.
To use the PointWorks interactive interface for controlling the scanner, the graphical display, and to
calibrated stored scanner data this code is supplied as a library that must be linked with the provided
source code and optionally additional software you develop. When compiling for debugging use
PointWorksLibraryD.lib. When compiling a release version use PointWorksLibrary.lib.
This code is not necessary to control the scanner or save scan data though the API routines.
The next module is the scanner API which enables acquisition and storage of scan data. The source
C++ source for the API is supplied with the scanner. Acuity attempts to keep this code as platform
independent as possible, though a minimum of a 32 bit processor is necessary.
The API and a scan collection demonstration program have been implemented by Acuity for Ubuntu
Linux as well as for Windows 10. The source files containing this code should be relatively
straightforward to port to other versions of Linux and integrate with embedded or other software,
assuming a C++ development environment. The demonstration program, AcuityCmdLineClient,
connects to a scanner, configures it, and takes and stores a scan. The Windows implementation is a
MSVC++ solution, and Cmake and make are used to build the Linux version.
The third module contains the PointWorks user interface code, proprietary calibration algorithms, and
display code, which is Windows 10 and MFC specific. This includes a library that may be linked with
the compiled user interface source code and your code to include the PointWorks interface and
calibration of scanner data. When compiling for debugging use PointWorksLibraryD.lib.
When compiling a release version use PointWorksLibrary.lib.
This module also includes source code for routines demonstrating the use of the PointWorks Library
routines, and obtaining and storing calibrated points from the library as they are generated. These
routines store calibrated points in a .LAS file as an example. This code is not necessary for
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controlling the scanner and storing raw scan data and is only implemented as part of PointWorks
under Windows 10.
5.1.2 Other Software Used: OpenGL and LASlib Source Code
If you wish incorporate other portions of the OpenGL or LASlib libraries and would like source code
and documentation for them they can be downloaded as described below.

5.1.2.1 OpenGL
The helpful site https://www.khronos.org/opengl/wiki/Getting_Started) is recommended for getting
started with openGL source downloading and programming. From their introduction:
If you are using C/C++, then you must first set up a build environment (Visual Studio project, GNU
makefile, CMake file, etc) that can link to OpenGL. Under Windows, you need to statically link to a
library called OpenGL32.lib (note that you still link to OpenGL32.lib if you're building a 64-bit
executable. The "32" part is meaningless). Visual Studio, and most Windows compilers, come with
this library.
On Linux, you need to link to libGL. This is done with a command-line parameter of "-lGL".

Also helpful is https://www.khronos.org/registry/OpenGL-Refpages/ and the sequence of OpenGL
tutorials athttp://www.opengl-tutorial.org/ . We recommend downloading, building, and running these
to use as a reference if you are planning extensive OpenGL programming.
You will also need glfw3dll.lib. See http://www.glfw.org/docs/latest/ .
5.1.2.2 LASLib
If you wish to extend the LAS file format handling capability of PointWorks you will need Martin
Isenburg's LASlib and LAStools. The source code may be downloaded under the GNU Lesser
General License as the files Laslib.zip and Lastools.zip from https://rapidlasso.com/ . If you
download these Acuity recommends building them as separate solutions from PointWorks using the
Visual Studio solution configurations provided with them and linking the resultant libraries in, at least
initially.
5.2

Command Interface

PointWorks source code serves as a demonstration of the use of the scanner API and programmable
features. It includes routines for controlling the scanner and scan acquisition and converting raw
scanner data to calibrated distance in Cartesian coordinates with the scanner axes intersecting at the
origin.
The programming interface consists of commands that set scanner operation modes and parameters
and perform scanning sequences. When a command function is called, a command packet is sent to
the scanner. The scanner will acknowledge each command after validating the parameters.
Commands that take time to implement, such as setting a motor speed, will be acknowledged before
the commanded condition is satisfied. The client software should wait for an acknowledgment of each
command before sending another.
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Completion of execution of a motor speed or position command while not scanning may be checked
by getting the scanner log, which includes the current speed of the motors and the position of the
azimuth motor. During scanning, motor speed commands will not take effect.
The API commands and data collection routines can be incorporated into real-time scan collection
control software. All of these commands use the routine int pushTCPCommand(ScannerData
*scanner) to send the scanner command and get the scanner's response using TCP.
5.2.1 Interface Header Files for Sending Scanner Commands
Each function’s parameter list starts with a pointer to a data structure for scanner data. Currently only
one scanner per network is supported. Each function returns the status returned by the scanner in a
command acknowledgement. The source code for these functions is located in
AcuityScanningAPI.cpp and AcuityScanningAPI.h.
The file datapackets.h contains definitions that are shared between the scanner and the client
software. These include the command packet, scan line header and point data format definitions, and
command, error, and scanner state codes. This file is a useful programming reference but should not
be altered as it is shared with internal scanner firmware.
The file AcuityScanningAPI.h contains the API function definitions and defines the
ScannerData structure that contains dynamic scanner information. The ScannerData generally need
not be accessed directly by client software other than the API functions.
5.2.2 Data Structures
The source code defining the data structures below is provided in datapackets.h but the definitions in
that file must not be changed, as they are shared with the scanner firmware.
TCPcommandPacket

Defines the format of information sent to the scanner to issue a command to it. All communications to
the scanner is in the form of one of these commands. This packet format is used by the scanner API
functions and would not typically need to be accessed directly by an application using the API.
TCPstatusPacket

Defines the format of the scanner acknowledgement of a command. Acks are sent immediately,
before any significant processing of the commands occurs, so receipt of an ack does not necessarily
mean the command completed successfully. During a scan, each scan line header contains a TCP
status packet, which may contain an acknowledgement and response data for a command issued
during a scan.
ALPacketHdr

This is the format for the header of the command responses and scan line data packets that the
scanner sends to the host. Not all header fields are used, depend on the type of packet sent. The
headers may contain only data in response to commands or they may be followed by a data log or
scan line data.
ScannerLog
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This contains information that may be requested by a scanner when it is not scanning. To see a
description of each field in the message/status window, click “Display Scanner Log” in PointWorks
to invoke the API routines getLog() and displayLog().
The log includes a history of “events”. Events include scanner state changes, internal scanner errors,
command input errors, and warnings. Values of event codes are included in datapackets.h
State change codes and command codes have values 0-99.
Internal error codes have values 100-199
Command input error codes have values 200-299
Internal scanner warning codes have value 300-399
The above require datapackets.h, TCPClass.h
5.2.3 Creating a Simple Scanner Control and Data Collection Program
Before attempting to write scanner control software it is recommended that one become familiar with
the order of commands needed for scanner operation by using the interactive PointWorks interface.
This is designed so that each command needed by the scanner has a button in the interface, to be
clicked after any parameters needed for the command have been entered in the text boxes. Each
interface button has a corresponding software handler in the file ScannerDlg.cpp that invokes one of
the scanner API functions.
Only a fraction of the code in PointWorks is needed to communicate with the scanner and acquire
scans. The Visual C++ solution SimpleProject.sln provides a minimal example of code required to
initialize the scanner and acquire scans. This can be found in the Acuity Scanner Interface working
directory along with Acuity Scanner Interface.sln.
In SimpleProject.sln, all the code is common to Pointworks except for the main routing
AcuityExample2.cpp and ConsoleClassStandalone.cpp. The latter replaces ConsoleClass.cpp of
PointWorks. This prints the scanning API output messages to stdout rather than the Pointworks status
console, which is not included in SimpleProject.sln. The printf to stdout can be replaced by code to
write to another console if desired.
5.2.4 Command Acknowledgments
Commands sent to the scanner are acknowledged without significant delay. Each command
acknowledgment returns a status value indicating whether the command was valid and whether it was
initiated successfully. The acknowledgement does not necessarily indicate that a command
completed successfully unless the command can be completed immediately.
The acknowledgement code values may range from 0 (success) to 399 and are listed in datapackets.h
as internal scanner error codes, invalid command and parameter error codes, and warning codes.
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5.2.5 Scan Data
Scan data comes from the scanner via ethernet using TCP. A scan header includes scanner-specific
calibration information. Each scan line is then sent as one or more ethernet packets. The data for each
line consists of a line header followed by scan data points. The header includes information about the
scan line such as the vertical and horizontal start positions and the number and spacing of the
samples. The format of the line header is provided in the source code. This is followed by point-bypoint data for all points. The point data is an Acuity proprietary format and is not published. Library
functions described below provide access to the data.
Range data are transmitted to the client in “raw” form before calibration. The .alf file format saves
this uncalibrated data. PointWorks performs calibration and transformation to XYZ coordinates
before display and optional saving to .las files or other formats. See the section Saving Data to
Different File Formats below.

5.3 Descriptions of Commands
5.3.1 Establishing Communication: Connect and Disconnect Commands
The PointWorks application and automatically attempts to connect with the scanner when it starts. If
the scanner is connected after PointWorks is started the (Re)Connect button can be used to connect to
the scanner. User applications can connect with and disconnect from a scanner using the connect and
disconnect commands.
int disconnectScanner(ScannerData *scanner)

Closes the TCP sockets connected to the scanner. Disconnection with this command should be done if
the scanner or the host computer software will be exiting and will be restarted and reconnected
without restarting both. The scanner must be SLEEPING or READY for this command to succeed.
int connectScanner(ScannerData *scanner)

Opens a TCP connection to the scanner. This happens in two parts. First a command socket is opened,
and when that succeeds, a separate data socket is opened. In the API implementation, the data socket
is opened and scan data is received via a separate thread and class, ReceiveDataClass.
5.3.2 Scan Setup: Scan Window and Speed Commands
There are two scan setup commands that must be used before scanning. These set the scan elevation
and azimuth parameters. So that the scanner can validate the parameters immediately, groups of
relevant parameters are sent with one command. The scanner validates the parameter values and if
they are acknowledged without error the parameters will be used in scans until replaced by reexecuting one of both commands or power is cycled.
The horizontal and vertical speeds of the scans and the scan start and stop vertical and horizontal
locations are based on the internal scanning motor encoder counts. The vertical scan resolution is
40,000 counts per mirror motor revolution. The beam deflection angle is double the mirror deflection
angle for elevation only. The beam deflection angle is double the mirror deflection angle. One
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encoder count is 314.159 microradians or .0180 degrees. The horizontal resolution is 40,000 counts
per 360 degrees of optical scan angle.
int elevationParameters(Scanner Class *scanner, int elevationSpeed, int
elevationStart, int samplesPerLine, int elevSampleSpacing, int multihit)

This command sets the speed of the scan mirror, the mirror encoder location at which laser ranging
starts, the number of sample points taken, the number of counts per sample for each vertical scan line,
the maximum number of return hits to acquire (1, 2 or 4) for each laser pulse, and the number of lines
to acquire. The valid range for elevationSpeed is 100,000 to 4,000,000 counts per second.
The laser pulse rate is determined by dividing the speed by the sample spacing and must lie within the
pulse rate limits of the scanner version being used. At 4,000,000 encoder counts per second, the
minimum valid spacing for an 800000 pulse per second scanner is 5.

int azimuthParameters(ScannerData *scanner, int azimuthSpeed, int
azimuthStart, int azimuthEnd)

This command sets the speed of the horizontal (azimuth) turret motor and the horizontal encoder
location at which the scan starts and ends. The speed must agree with the scan direction implied by
azimuthStart, azimuthEnd. Valid speeds are 0 to +/-400,000 counts per second. Valid start and
stop locations are -2,000,000,000 to 2,000,000,000. The zero location is the orientation of the turret
after the rotation that occurs after power up or after a sleep command is issued, facing forward.
If the azimuth start and end locations are the same, scanning will start at that location and continue at
the speed commanded until terminated by another command. If the commanded speed is zero
scanning will start at the start location and continue at that location until terminated. Issuing another
scan command will not terminate an indefinite scan.
int setGainReduction(ScannerData *scanner, int gainReduction)

This command adjusts the control gain, or stiffness, of the turret position servo controller. The turret
is capable of rapid changes of speed and direction and and can cause vibration, flexing or excessive
stresses when mounted on a lightweight or flexible platform. The default gain reduction is 6, which
generally works well with portable tripods. To prevent oscillations and significant vibration on some
mounts when the scanner is powered on, the SetGainReduction command with a higher factor
should be issued prior to issuing the scannerWake command. A gain reduction of 10 will prevent
oscillation even with the scanner base not attached to any support. Valid values are 1 to 10. The gain
reduction value is preserved across sleep and wake cycles, but not across power cycles.
5.3.3 Scan Initiation Commands
int startScan(ScannerData *scanner)

This command starts a scan. The elevation mirror speed is first set to that specified in the last
elevationParameters command. The turret then moves to enter the scan at the specified scan speed
and location using path planning and the scan occurs at constant speed. This command may be given
while a previous scan is still in progress. The command will be buffered and execute when the
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previous scan completes, so that scanning can be continuous. Only one scan may be buffered at a
time.
If no buffered scan is pending when a scan completes, the turret will stop. The mirror remains
spinning unless stopped with a sleep or elevationSpeed command.
int startScanCycle(ScannerData *scanner)

This command starts a continuous cycling scan. It uses the same parameters as StartScan, but upon
reaching the endpoint the turret cycles back and begins scanning in the opposite direction at the same
speed back to the scan starting point. This repeats continuously until the scan is terminated. Issuing
another scan command will not terminate an indefinite scan. The acceleration used during reversal
can be adjusted using the setGainReduction command. The default gain is the maximum and can
cause vibration or stresses when mounted on a lightweight platform.
Range sampling continues during the reversals, but the scan line spacing will not be constant and the
lines will curve somewhat depending on the turret acceleration and the mirror speed.
5.3.4 Positioning Commands
int elevationSpeed(ScannerData *scanner, int elSpeed)

Sets the mirror speed immediately. The valid ranges are 0 and 100000 to 4000000 encoder counts per
second. This command may be used to stop the mirror after a scan or to bring the mirror to speed
before issuing a scan command in order to reduce the delay between a scan command and initiation of
the scan.
int azimuthSpeed(ScannerData *scanner, int azSpeed)

Sets the turret speed. The valid ranges are -400000 to 400000 counts per second. This may be used to
move the turret at a controlled speed between scans. Note that the turret speed will change to that
given in the scan when a scan starts.
int azimuthPosition(ScannerData *scanner, int azPos)

Sets the turret position. The valid ranges are -2000000000 to 2000000000. This may be used to
position the turret between scans. The turret moves at up to +/-400000 encoder counts per second.
5.3.5 Commands for Terminating Scanning
int haltScan(ScannerData *scanner)

Halts scanning at the end of the current scan. Stops the azimuth motor. If another scan is queued
prior to the Halt Scan command it is flushed without execution. haltScan will not end an indefinite
or cycling command.
int abortScan(ScannerData *scanner)
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Aborts the current scan at the end of the current scan line. Stops the azimuth motor. This command is
processed asynchronously so that any scan in progress is aborted before completion. If a second scan
was queued prior to the Abort Scan command it is flushed without execution.

5.3.6 Sleep and Wake Commands
int scannerSleep(ScannerData *scanner)

Stops the elevation motor. Stops the azimuth motor. Zeros the azimuth location counter. Marks the
scan parameters as no scan setup issued. This command will halt any scan in progress, and cancel any
pending scan. This is similar to a system reset, but the ethernet connection is not interrupted.
int scannerWake(ScannerData *scanner)

This command must be issued after power up to start the scanner motors, and after a scannerSleep()
command to restart them. Tests the elevation motor. Powers up the azimuth motor and rotates to
scanner facing forward. Zeros the azimuth location counter. Marks the scan parameters as no scan
setup issued. This is similar to a system reset, but the ethernet connection is not interrupted.
This command takes several seconds to complete initialization, during which the scanner may not
respond to other commands. The best way to determine when this is complete is to wait several
seconds or send a getState() command every second or so. It will return with a timeout error or
scannerState = OK_WAKING until the scanner is ready, when it returns OK_READY.
5.3.7 Status and Scanner State Commands
int getLog(ScannerData *scanner)

Gets various information about the current scanner condition. This command may not be used while a
scan is in progress and will return an error code in that case. Some of this information is diagnostic
and can help Acuity determine if there is a scanner malfunction. See the ScannerLog structure
definition in datapackets.h
void displayLog(ScannerData *scanner)

Displays the information returned by getLog() in the Pointworks message window. Does not
communicate with the scanner.
int getState(ScannerData *scanner)

Gets a single value representing the present scanner state, such as ready, scanning, or error halt. See
the scanner state values in datapackets.h for the list of scanner states. Unlike getLog, this command
may be used while a scan is in progress.
int pushTCPCommand(ScannerData *scanner)
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Used by the API functions above to send commands to the scanner and receive command
acknowledgements and the state of the scanner. This function sends the command code in
and any associated parameters variables scannerData->s_TCPcommandPacket. Waits 1.5 seconds for
an acknowledgement before timing out.

5.3.8 Functions for Calibrating and Accessing Stored Scan Data
Scan data stored in .alf files may be exported into .las files for further manipulating and viewing. To
convert a file, use File->Open to open the .alf file, and then select .las as the file type using the File>Save As menu. Pointworks will call the functions convertToLAS() and fillLASpoint() to
generate the LAS file. The source code for both of these are provided in FileOutput.cpp and may be
modified as desired, for example to change the LAS version format.
For general file output and point by point processing, use the PointWorks Library function
scannerDialog::generateCalibratedPoints(), the entry point to the PointWorks library routines that
take a .alf file and generate calibrated X, Y, Z output. Its inputs are a FILE pointer to the open .alf file to

process, a scale factor, and a pointer to a function that is called to process or output each point. This
function may include any code desired for point by point processing or output and the function name
passed in via generateCalibratedPoints().
uint64_t scannerDialog::generateCalibratedPoints(FILE *alfFile, int *minX, int *maxX,
int *minY, int *maxY, int *minZ, int *maxZ, bool edge, double scale,
void(*fcnptr)(float, float, float, uint16_t, uint16_t, float, bool,
double, uint32_t, uint16_t, uint16_t, uint16_t, uint32_t));

Parameters:
FILE *alfFile: Pointer to an open .alf input file.
int *minX, int *maxX, int *minY, int *maxY, int *minZ, int *maxZ: Pointers to

variables that on return will contain the bounding box of the points generated.
bool edge: TRUE if the point is the first or last point of a line.
double scale: Passed through to the point processing function, not otherwise used.
void(*fcnptr): Pointer to the point processing function to be used on each point. The

calibrated point information is passed to this function, which should store or further process
the data. See the examplePointFunction below.
Returns: number of points generated. Each return creates a point. Other outputs are the X, Y, and Z
bounds of the output points.
Requires: ScannerDlg.h
To generate and access point data without the PointWorks GUI using only the PointWorks library
calibration procedures, scannerDialog::generateCalibratedPoints() may be called from
application code after opening the .alf file for binary reading. The function pointer passed in should
point to a user-written function that takes the arguments as shown in the examplePointFunction()
description below. For an example of using this see the definition in ScannerDlg.h and the
convertToLAS()and fillLASpoint() source in FileOutput.cpp.
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For each calibrated point generated, the function passed in to generateCalibratedPoints() will be
called with the point data passed in as parameters:
void examplePointFunction(float X, float Y, float Z, uint16_t signalStrength,
uint16_t ambient, float phi, bool edge, double scale, uint32_t lineNum,
uint16_t pulseNum, uint16_t returnNum, uint16_t numReturns, uint32_t
timestamp)

Parameters:
X, Y, Z: Scanner-centric coordinates of the return, in meters.
signalStrength: Measure of the return’s laser signal strength. Nonlinear, compressed at high
values.
ambient: Measure of ambient light level from the pulse direction for the return.
phi: the elevation angle of the laser pulse for the return. Redundant with X and Z.
edge: indication of whether the return is from a first or last point of a scan.
scale: scale factor to control scaling of (integer) points stored in the LAS file. Not related to
the X, Y, Z parameters.
lineNum: The line number of the scan for this return.
pulseNum: The laser pulse number in the current line.
returnNum: The return number for the current laser pulse.
numReturns: The number of returns detected for the current pulse.
timestamp: If GPS/GNSS PPS and NMEA sentence reception is active this will be the GMT
past midnight of the point. The resolution is 25 microseconds, so to convert to seconds past
midnight divide by 40,000. If GNSS input is not present, this is the time since the scanner
was last awakened from sleeping, in the same units.
The scanner log output includes the number of seconds since the last PPS pulse was received
up to 255 seconds. This will normally show 0 or 1 when receiving PPS data.
scanner: The data structure for the scanner configuration and state. See AcuityScanningAPI.h
for definition. This provides access to additional data that can be stored in output formats
such as .las files.
Source Code: FileOutput.cpp
5.3.9 Other Useful Class Member Functions (various classes)
These require datapackets.h, TCPClass.h, AcuityScanningAPI.h as well as files shown
below each description.
bool ConsoleClass::printConsole(CString string)

Provides a resource arbitrated console print command. Strings printed in a given call will not be
broken by strings from other threads. For embedded and non-Windows applications it will be
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necessary to replace this function with an OS and hardware-specific string print operation, for
example to a serial port. Does not communicate with the scanner.
Requires: Consoleclass.h, ScannerDlg.h
void ReceiveDataClass::ReceiveDataClass(SRIPacket *packet)

Instantiates a thread to establish a TCP socket connection for receiving data from the scanner. This
thread then receives all command acknowledgements and scan data. If the data includes a command
acknowledgement, this is signaled using an event flag, typically being waited on by a command
thread that sent the most recent command.
Requires: ThreadClass.h, ReceiveDataClass.h
void ReceiveDataClass::logBinaryScanLine(SRIPacket *packet)

Used to store scan line data to the during scan acquisition. Does not communicate with the scanner.
Requires: ThreadClass.h, ReceiveDataClass.h
__int64 ScannerClass::convertToLAS(const char *filename)

Stores the scan data in a LAS file, a widely used format for Lidar data interchange. Before saving the
data is processed as it is read from the currently open .alf file according to the averaging, decimation,
and geometric clipping settings selected in the PointWorks interface. If this is being used
independently of the interface, the appropriate processing variables should be set prior to invocation.
Returns the length of the written file, in bytes.
Requires: ConsoleClass.h, ScannerDlg.h, laswriter.hpp, lasreader.hpp
bool TCPClass::initTCPclient(const char *machineName)

Initializes a TCP socket on the host and connects to the scanner. This is used by
ReceiveDataClass to establish a socket for receiving communications from the scanner, and
should be also called to establish a separate socket for sending commands to the scanner.
Returns 1 for success or 0 for error.
Requires: Consoleclass.h
bool ScannerClass::sendTCPCommand(TCPcommandPacket *newPacket, bool
verbose)

Computes a checksum and sends a command packet with checksum to the scanner. Does not wait for
the scanner ack. This is called by pushTCPCommand.
Returns 1 for success or 0 for error.
Requires: Consoleclass.h
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int TCPClass::receiveTCP(char *newPacket, int length, unsigned timeout)

Used by ReceiveDataClass::RunMain() to get data from the scanner. Waits until the full data
requested is received, timeout in microseconds has elapsed, or returns an error if one occurred.
Typically, first a fixed length header is read, which includes the total number of byes transmitted by
the scanner. Acknowledgements to most commands contain only a header. Scan lines comprise a
header plus point data.
Ensures that all transmissions from the scanner are flushed from the TCP socket pipeline.
Returns the number of bytes read or -1 for error.
Requires: Consoleclass.h
void getAPIVersion(char *APIversion)

Copies the API Version string into the buffer provided.

5.4 Exporting a Scan
To save a scan to another name or to another format, use File->Save As, and select the type of file to
output. Scans of essentially unlimited length may be captured and saved in these formats, but display
is limited to approximately 15 million points. To display a larger file, use the decimation options in
the PointWorks display settings.
5.4.1 Acuity Lidar File (.alf)
This is the native format for Acuity scanner data, and is the format in which data is stored as scans are
acquired. Data is grouped into scan lines with a header followed by individual point data in binary
format. An Acuity lidar file may reduced in size by saving as another .alf with the interface
decimation values greater than one, resulting in fewer points being saved. No other interface settings
(averaging, distance limits, etc) are applied when saving to .alf files.
5.4.2 LAS Format (.las)
When Save As .LAS is selected, the scan data is calibrated and saved in LAS version 1.4. This is a
widely used format for Lidar data interchange. It can be used to save Acuity data for examination and
processing in many free and commercial point cloud processing packages. See the LAS
SPECIFICATION VERSION 1.4 – R13, 15 July 2013 published by The American Society for
Photogrammetry & Remote Sensing for details. PointWorks presently stores LAS files using Point
Record Format 8.

5.4.3 Defining other Formats
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The source code for the .LAS file output is in fileoutput.cpp, in fillLASpoint() and convertToLAS
This code may be modified as desired, for example to change the LAS version or record format
stored, or to store data in a user-defined format.
As shown in fileoutput.cpp, LAS files or other output formats can be created by first opening a file
for writing and initializing any necessary file header and then starting the calibrated point calculation
process with a call to dlgptr->generateCalibratedPoints(), as shown in convertToLAS(). For each
scan point generateCalibratedPoints() will call back the function specified in its last argument. That
function (examplePointFunction() in FileOutput.cpp) then writes the point data to the output file. In
FileOutput.cpp, fillLasPoint() is used by examplePointFunction() to write each output point, which
may include some user-defined data and custom formatting.
The modified code is then linked with the PointWorks Library. When the PointWorks Save As
function is used, the user-modified code will save the file in the format coded.
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